
บทที่ 1 
หนังสืออิเล็กทรอนิกส์ 

ความหมายของหนังสืออิเล็กทรอนิกส์ 
        e-Book คืออะไร 

        e-Book (electronic + Book = e-Book) ได้กลายมาเป็นส่วนหนึ่งของการปฏิวัตินวัตกรรมที่เร็วมาก 

(Hottest) บนระบบเครือข่ายอินเทอร์เน็ตทุกวันนี้ ผู้บริหารการศึกษาในรัฐเท็กซัล ได้เห็นความจ าเป็นที่ต้อง

ใช้ e-Book ส าหรับรายวิชาที่มีสารสนเทศเปลี่ยนแปลงอย่างรวดเร็ว และจะต้องลงทุนส าหรับ e-Book เป็น

จ านวนมาก ซ่ึงท ามากกว่า 6 ปี มาแล้ว 

        e-Book เป็นหนังสืออิเล็กทรอนิกส์ที่ไร้กระดาษที่ปรากฏขึ้นใน Cyberspace จะมีผลกระทบต่อการ

ผลิตหนังสือการดาษที่มีมาก่อนมากน้อยเพียงใด ย่อมขึ้นอยู่กัลป์เทคโนโลยีที่น ามาใช้ท าให้เกิดความ

สะดวกสบาย และความคุ้มค่าในระยะสั้น ระยะยาว และวัฒนธรรมการอ่านจากจอคอมพิวเตอร์สามารถท า

ให้เปลี่ยนไปด้วย 

         e-Book หมายถึง หนังสืออิเล็กทรอนิกส์ที่อยู่ในรูปแบบดิจิตัล ผู้อ่านสามารถอ่านโดยใช้เคร่ือง

คอมพิวเตอร์หรือเคร่ืองอ่าน e-Book (Rocket e-Book Softbook,Microsoft Reader) e-Book มีคุณลักษณะ

พิเศษกว่าหนังสือกระดาษหลายประการ อาทิ แสดงผลด้วย ภาพ ข้อความ เสียง ภาพเคลื่อนไหว เป็นต้น ซ่ึง

สามารถเปิดอ่านเหมือนหนังสือทั่วไป และพกพาหนังส าจ านวนมากติดตัวไปได้ทุกที่ ทุกเวลา สามารถ 

Download มาไว้ใน Palm Pilot เปิดออกมาอ่านตามต้องการและยังสามารถเช่ือมโยงกับข้อความต่างๆ 

ภายในตัวหนังสือหรือภายนอกเว็บไซต์อื่นๆ จากอินเทอร์เน็ต ย่ิงกว่านั้นผู้อ่านสามารถอ่านพร้อมๆ กันได้

โดยไม่ต้องรอการยืมหรือคืนเหมือนหนังสือกระดาษในห้องสมุด 

        e-Book ท างานเหมือน Web-brower สามารถดาวน์โหลดมายังคอมพิวเตอร์ได้ สามารถอ่านในรูปแบบ 

Offline ได้ หรือพิมพ์ก็ได้ e-Book ก าลังปฏิวัติรูปแบบการจัดการและการน าเสนอสารสนเทศ ที่เปลี่ยนไป

จากการน าเสนอเนื้อหาแบบเดิมและพร้อมๆ กับการปฏิวัติ  e-Learning รวมทั้งการพัฒนาศักยภาพของ

คอมพิวเตอร์ 

         e-Book จะมุ่งการเรียนรู้ด้วยการเห็น และการปฏิสัมพันธ์ มีการสะท้อนโลกกว้างให้เห็นและท าให้

เกิดการปฏิสัมพันธ์ แม้อยู่ไกลกันคนละซีกโลก โดยที่การสร้าง e-Book ที่ใช้ซอฟต์แวร์จัดระบบเป็นพิเศษ

ในแฟ้ม EXE หรือ PDF 
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         ขอบเขตของหนังสืออิเล็กทรอนิกส์ไม่จ ากัดแต่เพียงการแปลงหนังสือรูปแบบกระดาษมาเป็นหนังสือ

รูปแบบอิเล็กทรอนิกส์ แต่จะหมายรวมถึง ข้อมูล สารสนเทศ บทความต่างๆ ในลักษณะข่าวสาร หนังสือ 

วารสารอิเล็กทรอนิกส์ รวมทั้งคู่มือการใช้งานช่วยเหลือในโปรแกรมคอมพิวเตอร์ เว็บเพ็จแฟ้มข้อมูลใน 

CD ROM และ World Wind Web 

         จากความหมายที่กล่าวมาทั้ง 3 ลักษณะ สามารถสรุปได้ว่า หนังสืออิเล็กทรอนิกส์ หมายถึง การน า

หนังสือหนึ่งเล่มหรือหลายๆ เล่ม มาออกแบบใหม่ให้อยู่ในรูปของอิเล็กทรอนิกส์โดยปรับปรุงหรือ

เปลี่ยนแปลงข้อมูลเหล่านั้นให้อยู่รูปของตัวอักษร, ภาพนิ่ง , ภาพเคลื่อนไหว,เสียง,ลักษณะที่ตอบโต้กันได้ 

(interactive) และการเช่ือมโยงแบบไฮเปอร์เท็กซ์ สามารถท าบุ๊คมาร์กและหมายเหตุประกอบตามที่ผู้ใช้

ต้องการได้ โดยอาศัยพื้นฐานของเล่มหนังสือเป็นหลัก 

ลักษณะของหนังสืออิเล็กทรอนิกส์ 
             หนังสืออิเล็กทรอนิกส์มีโครงสร้างเหมือนๆ กับหนังสือเล่มทั่วๆ ไปโดยจะประกอบด้วยหน้าปก

หน้า-หลัง, สารบัญ , เนื้อหาภายในเล่ม และดัชนี เนื้อหาภายในเล่มอาจจะแบ่งออกเป็นบทแต่ละบทมี

จ านวนหน้ามากน้อยแตกต่างกันไป ในแต่ละหน้าจะประกอบด้วยตัวอักษร, ภาพนิ่ง, ภาพเคลื่อนไหว, เสียง 

(อาจจะแสดงทันทีหรือปรากฏเป็นปุ่มไว้ให้กดเรียกก็ได้)หนังสืออิเล็กทรอนิกส์ตะแตกต่างจากหนังสือเล่ม

ในการพลิกหน้า โดยที่ไม่ได้มีการพลิกหน้าจริง หากแต่เป็นไปในลักษณะของการซ้อนทับกัน (Barker and 

Singh, 1985 quoted in Barker and Manji. 1991 : 276) สิ่งที่แตกต่างกันระหว่างหนังสืออิเล็กทรอนิกส์กับ

หนังสือเล่มอย่างเด่นชัด คือ การปฏิสัมพันธ์และความเป็นพลวัต (Barker,1996 : 14) ซึ่งอาจจะแตกต่างกัน

ล่างในหนังสืออิเล็กทรอนิกส์แต่ละเล่ม ทั้งนี้ขึ้นอยู่กับจุดประสงค์การใช้งาน และการปฏิสัมพันธ์จากผู้อ่าน 

หนังสืออิเล็กทรอนิกส์มีลักษณะเหมือนกับหนังสือเล่มดังภาพประกอบ 2 คือ มีหน้าปกเพื่อบอกข้อมูล

ต่างๆ เกี่ยวกับหนังสือ หากใน 1 หน้า มีข้อมูลเป็นหน้าคู่ ด้านซ้ายมือเป็นหน้าซ้ายด้านขวามือจะเป็นหน้า

ขวา กดปุ่มไปหน้าก็จะไปยังหน้าต่อไป กดปุ่มถอยหลังจะกลับไปหน้าก่อน นอกจากนี้ยังสามารถกระโดด

ข้ามไปยังหน้าที่ผู้อ่านต้องการได้อีกด้วย หน้าสุดท้ายจะเป็นหน้าก่อนออกจากโปรแกรม ถึงแม้ว่าหนังสือ

อิเล็กทรอนิกส์จะคล้ายกับหนังสือเล่มมากแต่ข้อจ ากัดที่มีอยู่มากมายในหนังสือเล่มไม่สามารถส่งอิทธิพล

มายังหนังสืออิเล็กทรอนิกส์แต่อย่างใด 
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รูปแบบและการเปรียบเทียบหนังสืออิเล็กทรอนิกส์ 3 รูปแบบ 
             รูปแบบของหนังสืออิเล็กทรอนิกส์ รูปแบบของหนังสืออิเล็กทรอนิกส์สามารถแบ่งออกได้เป็น

หลายรูปแบบด้วยกันดังนี้ 

             1. รูปแบบของหนังสืออิเล็กทรอนิกส์แบ่งตามลักษณะการเข้าถึงข้อมูลและการอ่าน 

(Collis, 1991 : 365) รูปแบบนี้ จะเป็นการแบ่งประเภทของหนังสืออิเล็กทรอนิกส์ได้ชัดเจนมาก 

ที่สุดกวา่ทุกๆ แบบที่มี โดยแบ่งออกเป็น 

                          1.1 หนังสืออิเล็กทรอนิกส์อ้างอิง (Automated Reference Books) หนังสืออิเล็กทรอนิกส์

อ้างอิงใช้การเข้าถึงข้อมูลในลักษณะการสุ่ม (Random) ผู้อ่านจะค้นหาค าที่ต้องการทราบและอ่านจนจบ

เนื้อหานั้น จากนั้นจึงค้นหาที่ต้องการทราบต่อไปหนังสืออิเล็กทรอนิกส์อ้างองิสามารถดูภาพจากฐานขอ้มลู

เอนไซโคลปิเดีย จัดเป็นแหล่งทรัพยากรซึ่งผู้ใช้สามารถค้นหาหรือเลือกอ่านหนังสือที่มีอยู่ได้ง่ายมาก ใน

อนาคตหนังสืออิเล็กทรอนิกส์ประเภทนี้จะมีการเปลี่ยนแปลงอย่างรวดเร็วมาก ไม่จะเป็นด้านคุณภาพหรือ

ปริมาณในการบรรจุของฐานข้อมูล และทางที่ผู้อ่านสามารถค้นหาและใช้ข่าวสาร แต่ทั้งนี้ทั้งนั้นก็ต้อง

คงไว้ซึ่งโมเดลการอ้างอิงอยู่ 

                          1.2 ห นั งสื อ เรี ย น อิ เล็ ก ท ร อ นิ ก ส์  (Automated Textbook Books) ห นั งสื อ เรี ยน

อิเล็กทรอนิกส์มีลักษณะการเข้าถึงข้อมูลส่วนใหญ่แบบอ่านไปตามล าดับ (Sequence) จากนั้นก็จะมีการอ่าน

เนื้อหาเหล่านั้นไปเร่ือยๆ จนจบบท และอาจอ่านบทต่อไปตามล าดับหรือเลือกหัวข้อใหม่ตามความสนใจ

ของผู้อ่าน หนังสือเรียนอิเล็กทรอนิกส์จะแตกต่างจากหนังสืออ้างอิง 

อิเล็กทรอนิกส์ตรงที่ผู้อ่านจะมีความคาดหวังที่จะได้รับความรู้จากการอ่านหนังสือ หนังสืออิเล็กทรอนิกส์ 

รูปแบบนี้จะเป็นตัวเสริมค านิยามของหนังสือเรียนโดยจะขยายความรู้ความเข้าใจให้กับผู้เรียนทางอ้อมโดย

ใช้สื่อหลากหลายชนิด 

             2. รูปแบบของหนังสืออิเล็กทรอนิกส์แบ่งตามช่องทางการสื่อส าร  (Barker, 1991 : quoted in 

Barker, 1992 : 140 – 141) สามารถแบ่งออกได้เป็น 2 ประเภท คือ 

                          2.1 หนังสืออิเล็กทรอนิกส์ที่ใช้ช่องทางการสื่อสารทางเดียว  เป็นหนังสืออิเล็กทรอนิกส์ที่

ผู้อ่านสามารถรับสารได้เพียงช่องทางเดียว เช่น ใช้ตาดูหรือใช้หูฟังแต่เพียงอย่างใดอย่างหนึ่งเท่านั้น ได้แก่ 

หนังสือเรียนอิเล็กทรอนิกส์ (Text Books), หนังสืออิเล็กทรอนิกส์ภาพนิ่ง (Picture Books), หนังสือ

อิเล็กทรอนิกส์หลายภาษา ( Talking Books ) เป็นต้น 
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                          2.2 หนังสืออิเล็กทรอนิกส์ที่ใช้ช่องทางการสื่อสารหลายทาง เป็นหนังสืออิเล็กทรอนิกส์ที่

ผู้อ่านสามารถรับข่าวสารได้หลายช่องทาง เช่น ใช้ตาดู ใช้หูฟัง ใช้มือสัมผัสหน้าจอได้แก่ หนังสือ

อิเล็กทรอนิกส์สื่อประสม ( Multimedia Books ), หนังสืออิเล็กทรอนิกส์รวมสื่อ (Poly Media Books), 

หนังสืออิเล็กทรอนิกส์ไฮเปอร์มีเดีย (Hypermedia Books) เปน็ต้น 

             3. รูปแบบของหนังสืออิเล็กทรอนิกส์แบ่งตามหน้าที่ (Barker and Giller,1992d,quoted 

in Barker,1992 : 140) สามารถแบ่งออกได้เป็น 4 รูปแบบ คือ 

                          3.1 หนังสืออิเล็กทรอนิกส์ส าหรับเก็บเอกสารส าคัญ (Archival) จะมีที่เก็บข้อมูลข่าวสาร

ขนาดใหญ่ในรูปแบบของฐานข้อมูล วิธีใช้งานผู้ใช้ขั้นปลาย สามารถใช้งานได้หลากหลายรูปแบบ ตัวอย่าง

หนังสือประเภทนี้ ได้แก่ สารานุกรมโกรเลียร์ (Grolier Encyclopedia) สารานุกรมมัลติมีเดียคอมพ์ตัน

(Compton’s Multimedia Encyclopedia )เป็นต้น 

                          3.2 หนังสืออิเล็กทรอนิกส์ให้ข่าวสารความรู้ (Information) จะมีลักษณะคาบเกี่ยวกับ

หนังสืออิเล็กทรอนิกส์รูปแบบแรก แต่ข่าวสารจะกินความแคบกว่าแบบแรก และมีลักษณะเฉพาะมากกว่า 

มีความสัมพันธ์กับหัวข้อเร่ืองใดหัวข้อเร่ืองหนึ่งโดยเฉพาะ ตัวอย่างเช่น หนังสือเรียนแพทยศาสตร์

ออกซฟอร์ดบนซีดีรอม หนังสือรายช่ือเพลงนิมบัส (Nimbus Music Catalogue) เป็นต้น 

                          3.3 หนังสืออิเล็กทรอนิกส์เพื่อการสอน (Instructional) เป็นหนังสืออิเล็กทรอนิกส์ที่มี

ประสิทธิภาพ และมีประโยชน์มากในการถ่ายทอดความรู้ความช านาญเพื่อสนับสนุนการเรียนรู้และการ

อบรม ผู้เรียนจะได้รับความรู้และทราบความก้าวหน้าในการเรียนของตนหนังสืออิเล็กทรอนิกส์ประเภทนี้

บางส่วนจะมีการประเมินและประยุกต์ตามรูปแบบการเรียนรู้ของแต่ละคน จะมีการน าเสนอให้เหมาะสม

กับผู้เรียนแต่ละคน ตัวอย่างได้แก่ หนังสืออิเล็กทรอนิกส์ที่มีการออกแบบหน้าจอส าหรับคอมพิวเตอร์

พื้นฐานการอบรม (Computer –Based Training) 

                          3.4 หนังสืออิเล็กทรอนิกส์แบบต้ังค าถาม (Interrogational) หนังสืออิเล็กทรอนิกส์

รูปแบบนี้มีจุดมุ่งหมายเพื่อการทดสอบ , สอบย่อย และประเมินผลกิจกรรมโดยวัดจากความรู้ที่ได้จา

การศึกษาหัวข้อที่เกี่ยวข้อง หนังสืออิเล็กทรอนิกส์แบบตั้งค าถามจะประกอบด้วย 3 ลักษณะที่ส าคัญคือ 

ธนาคารตั้งค าถามหรือแบบฝึกหัด , ข้อสอบ, ลักษณะการประเมินผลและระบบผู้เช่ียวชาญ จะมีการ

วิเคราะห์ผลทีได้จาการเรียน มีการแข่งขันและพิจารณาให้ระดับที่เหมาะสมกับความสามารถของผู้เรียน 

             4. รูปแบบของหนังสืออิเล็กทรอนิกส์แบ่งตามชนิดของข้อมูลข่าวสารและเครื่องอ านวยความ

สะดวก (Barker,1991a,quoted in Barker, 1992 : 140-141) สามารถแบ่งออกได้เป็น 10 ประเภท คือ 
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                          4.1 หนังสือเรียนอิเล็กทรอนิกส์ (Text Books) ในระยะแรกจะมีลักษณะเป็นเส้นตรงมี

โครงสร้างเป็นตัวอักษร (Text) ต่อมาจะมีลักษณะที เป็นมัลติมี เดียมากขึ้นโดยใช้คุณสมบัติของ

ไฮเปอร์เท็กซ์ในการน าเสนอ 

                          4.2 หนังสืออิเล็กทรอนิกส์ภาพเคลื่อนไหว (Moving Picture Books) มีโครงสร้างจาก

ภาพเคลื่อนไหวสั้นๆ (Animation Clips) หรือภาพวิดีโอ (Motion Video Segment) หรือทั้งสองอย่างรวมกัน 

                          4.3 หนังสืออิเล็กทรอนิกส์หลายภาษา (Talking Books) จะมีลักษณะเป็นเนื้อหาประกอบ

ค าบรรยาย เพื่อให้ง่ายต่อการรับรู้ของผู้อ่าน 

                          4.4 หนังสืออิเล็กทรอนิกส์ภาพนิ่ง (Static Picture Books) จะประกอบไปด้วยภาพนิ่ง

หลายๆ ชนิดรวมกัน ภาพแต่ละภาพจะมีคุณภาพที่แตกต่างกันไปตามความเหมาะสมของงาน 

                          4.5 หนังสืออิเล็กทรอนิกส์สื่อประสม (Multimedia Books) เป็นการรวมช่องทางการ

สื่อสารสองทางหรือมากกว่านั้นเข้าด้วยกันเพื่อเข้ารหัสข่าวสาร เป็นการรวมตัวอักษร, ภาพนิ่งและ

ภาพเคลื่อนไหวมารรวมไว้ด้วยกันตามโครงสร้างแบบเน้นตรง เมื่อผลิตเสร็จสื่อจะออกมาในรูปของสื่อ

เดียว ได้แก่ จานแม่เหล็กหรือ ซีดีรอม 

                          4.6 หนังสืออิเล็กทรอนิกส์รวมสื่อ (Poly Media Books) มีลักษณะตรงกันข้ามกับหนังสือ

อิเล็กทรอนิกส์ส่ือประสม โดยใช้การรวมสื่อที่แตกต่างกัน ได้แก่ ซีดีรอม, จานแม่เหล็ก, กระดาษ, เครือข่าย

คอมพิวเตอร์และอื่นๆ เพื่อส่งข้อมูลข่าวสารไปยังผู้ใช้ 

                          4.7 หนังสืออิเล็กทรอนิกส์ไฮเปอร์มี เดีย (Hypermedia Books) จะมีลักษณะคล้ายกับ

หนังสืออิเล็กทรอนิกส์สื่อประสม คือ ใช้การสื่อสารหลายช่องทาง แต่จะมีโครงสร้างเป็นแบบนอนลีเนียร์ 

โดยมีโครงสร้างแบบใยแมงมุม 

                          4.8 หนังสืออิเล็กทรอนิกส์ผู้เชี่ยวชาญ (Intelligent Electronic Books) มีการบรรจุเทคนิค

ปัญญาเทียม เช่น ระบบผู้เช่ียวชาญ (Expert System) และระบบเครือข่ายประสาท (Neural Networks) ซึ่ง

สามารถท าให้ผู้เรียนเกิดการเรียนรู้และประยุกต์ให้เข้ากับพฤติกรรมของผู้เรียนแต่ละคนที่มีความแตกต่าง

กัน 

                          4.9 หนังสืออิเล็กทรอนิกส์ทางไกล (Telemedia Electronic Books) ต้องอาศัยการสื่อสาร

ทางไกลช่วยในการน าเสนอเนื้อหา เช่น การเรียนการสอนในระบบเทเลคอนเฟอเรนซ์ การส่งข้อความทาง

อีเมล์ ตลอดจนเป็นทรัพยากรในการสอนทางไกล เช่นในห้องสมุดดิจิตอล 
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                          4.10 หนังสืออิเล็กทรอนิกส์ไซเบอร์บุ๊ค (Cyberbook Books) ใช้เทคนิคของความจริง

เสมือน (Virtual Reality) ในการสร้างสถานการณ์จ าลองเพื่อให้ผู้ เรียนรู้สึกเหมือนได้ เข้าไปอยู่ใน

ประสบการณ์จริง 

การเปรียบเทียบหนังสืออิเล็กทรอนิกส์ 3 รูปแบบ 
การที่ยกหนังสืออิ เล็กทรอนิกส์ทั้ ง 3 ประเภทคือ  หนังสืออิ เล็กทรอนิกส์ภาพนิ่ งหนังสือ

อิเล็กทรอนิกส์ภาพเคลื่อนไหวและหนังสืออิเล็กทรอนิกส์มัลติมีเดียมาเปรียบเทียบนั้นเพราะว่าหนังสือ

อิเล็กทรอนิกส์ทั้ ง  3 ประเภทนี้ จัดเป็นพื้นฐานของหนังสืออิ เล็กทรอนิกส์ทั้ งหมดที่มีอ ยู่หนังสือ

อิเล็กทรอนิกส์ 2 ชนิดแรกสนับสนุนคอมพิวเตอร์ช่วยการเรียนรู้ (Computer –Assisted Learning) ส่วนชนิด

สุดท้ายเป็นหนังสืออิเล็กทรอนิกส์ที่สนับสนุนสิ่งแวดล้อมการเรียนรู้แบบปฏิสัมพันธ์เพื่อสนับสนุนการ

เรียนแบบค้นพบของคอมพิวเตอร์ช่วยการเรียนรู้ 

             1. หนังสืออิเล็กทรอนิกส์ภาพนิ่ง (Static Picture Books) 
    หนังสืออิเล็กทรอนิกส์ภาพนิ่งเป็นการรวบรวมภาพที่ เกี่ยวข้องกันเอาไว้ด้วยกันตามแต่

จุดประสงค์ใดๆ ก็ตามที่ผู้ผลิตต้องการยกตัวอย่างเช่น  ใช้ประกอบการสอน เป็นต้นโมเดลค านิยามของ

หนังสืออิเล็กทรอนิกส์ภาพนิ่งมีดังภาพประกอบ 3 อันประกอบด้วย ปกหน้า,กลุ่มภาพนิ่ง, และปกหลัง 

ภาพนิ่งนี้อาจเป็นภาพจากวิดีโอ, ซีดีรอม หรือจากที่อื่นๆ ก็ได้ข้อจ ากัดอย่างหนึ่งของหนังสืออิเล็กทรอนิกส์

ภาพนิ่งคือ ขาดโครงสร้างของบทแต่หากจะให้มีก็สามารถท าได้ไม่ยากโดยเก็บรวบรวมภาพที่มีลักษณะ

แนวเดียวกัน เช่น หัวข้อเกี่ยวกับสัตว์ซึ่งเป็นบทที่อยู่ตามล าพังไม่ขึ้นกับบทอื่นใช้รวบรวมสัตว์พวกแมว , 

หมา, นก และสัตว์อื่นๆ สิ่งส าคัญส าหรับหนังสืออิเล็กทรอนิกส์ภาพนิ่ง คือ ต้องมีการควบคุททรงเลือกที่

หลากหลายแทนลูกศรในโมเดลของมันซึ่งอาจควบคุมหนังสืออิเล็กทรอนิกส์ทั้งเล่มหรือเป็นบางตอนก็ได้ 

             2. หนังสืออิเล็กทรอนิกส์ภาพเคลื่อนไหว (Moving Picture Book) 
    หนั งสืออิ เล็กทรอนิกส์ภาพเคลื่อนไหวเป็นหนังสืออิ เล็กทรอนิกส์แบบหนึ่งซึ่งบรรจุ

ภาพเคลื่อนไหวไว้มากว่าหนังสืออิเล็กทรอนิกส์ภาพนิ่งภาพเคลื่อนไหวเหล่านี้อาจมาจากคอมพิวเตอร์หรือ

สื่อจากสื่ออื่น เช่น วิดีโอหรือซีดีรอม ภาพจะมีการน าเสนออย่างไรขึ้นอยู่กับอัตราที่ตั้งไว้อาจน าเสนออย่าง

รวดเร็ว, ช้าหรือปกติก็ได้โมเดลค านิยามของหนังสืออิเล็กทรอนิกส์ภาพเคลื่อนไหวมีดังภาพประกอบ  4 

ภาพเคลื่อนไหวเป็นการแสดงชุดของภาพที่มีลักษณะคล้ายกันต่อเนื่องกันอย่างรวดเร็วโมเดลของหนังสือ

อิเล็กทรอนิกส์ชนิดนี้เหมือนกับโมเดลของหนังสืออิเล็กทรอนิกส์ภาพนิ่งโดยจะมีปกหน้าและปกหลัง ตรง

กลางจะประกอบด้วยโครงสร้างของบทที่มีลักษณะเหมือนกันดังภาพประกอบ 1 แต่ละบทจะประกอบด้วย 



 7 

ภาพจ านวยมากซึ่งเรียงล าดับตามหัวข้อหรือเนื้อเร่ืองถ้าต้องการแบ่งเป็นหมวดหมู่หรือย่อยไปกว่านั้นก็

สามารถก าหนดให้เพิ่มขึ้นได้อีกในโครงสร้างความมีการควบคุมทางเลือกที่หลากหลายของหนังสือ

อิเล็กทรอนิกส์ภาพเคลื่อนไหวโดยสามารถเล่น , หยุดด ู, ถอยหลัง , ไปหน้าได้ตามที่ผู้อ่านต้องการด้วย 

             3. หนังสืออิเล็กทรอนิกส์มัลติมีเดีย (Multi – Media Books) 
    หนังสืออิเล็กทรอนิกส์มัลติมีเดียประกอบด้วยตัวอักษรเสียงและภาพรวมกันโครงสร้างหน้าของ

หนังสืออิเล็กทรอนิกส์มัลติมีเดียมีดังภาพประกอบ 1 ในส่วนที่แรเงาในภาพน าเสนอตัวอักษร เสียง และ

ภาพตามที่ ผู้ใช้เลือกภาพของหนังสืออิเล็กทรอนิกส์มัลติมีเดียอาจเป็นภาพธรรมดาที่มีเอฟเฟค หรือ

ภาพเคลื่อนไหวก็ได้ในหนึ่งหน้าจอจะประกอบไปด้วยหลายๆส่วนดังภาพประกอบ  5 ได้แก่ ตัวอักษร 

ภาพนิ่ง ภาพวิดีโอ กรอบโต้ตอบระหว่างผู้อ่านกับคอมพิวเตอร์ในหน้านี่อาจใส่เสียงด้วย โดยอาจใส่ไว้ใน

รูปของปุ่มเพื่อให้ผู้เรียนเลือกใช้หนังสืออิเล็กทรอนิกส์หลายๆ  ประเภท รวมทั้งหนังสืออิเล็กทรอนิกส์

มัลติมีเดียจะได้รับความสะดวกสลายจากตัวจัดการซ้อนทับ (Overlay Manager) ดังภาพประกอบ 6 หน้าจอ

ทั้งหมดที่ผู้ใช้มองเห็นเกิดจากการรวมตัวของแต่ละหน้าจอทางตรรกะวิทยา (Logical Screen) ที่มีอยู่โดยแต่

ละหน้าจอจะมีภาพพื้นฐานเป็นภาพหลัก ตัวซ้อนทับ 1,2 ,3 และ 4 จะปรากฏขึ้นเอง หรือต้องอาศัยการกด

ปุ่มช่วยขึ้นอยู่กับผู้ออกแบบโปรแกรมว่าจะออกแบบไว้อย่างไรตัวจัดการการซ้อนทับมีประโยชน์ต่อการ

รวบรวม การควบคุมโครงสร้าง และการที่จะเป็นหนังสืออิเล็กทรอนิกส์มัลติมีเดียจะต้องอาศัยพื้นฐาน

โมเดลตัวจัดการซ้อนทับ (Overlay Model) ด้วย 

ข้อดีและข้อจ ากัดของหนังสืออิเล็กทรอนิกส์ 
1. ข้อดีของหนังสืออิเล็กทรอนิกส์ มีข้อดีดังต่อไปนี้ 

1.1 เป็นสื่อที่รวมเอาจุดเด่นของสื่อแบบต่างๆ มารวมอยู่ในสื่อตัวเดียว คือสามารถแสดง

ภาพ แสง เสียง ภาพเคลื่อนไหว และการมีปฏิสัมพันธ์กับผู้ใช้ 

1.2 ช่วยให้ผู้เรียนเกิดพัฒนาการเรียนรู้และเข้าใจเนื้อหาวิชาได้เร็วขึ้น  (สิทธิพรบุญญานุ

วัตร,2540 : 24) 

1.3 ครูสามารถใช้หนังสืออิเล็กทรอนิกส์ในการชักจูงผู้เรียนในการอ่าน, การเขียน, การฟัง

และการ พูดได้ (Roffey, 1995) 

1.4 มีความสามารถในการออนไลน์ผ่านเครือข่ายและเช่ือมโยงไปสู่โฮมเพจและเว็บไซต์

ต่างๆอีกทั้งยังสามารถอ้างอิงในเชิงวิชาการได้ 
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1.5 หากหนังสืออิเล็กทรอนิกส์ออนไลน์ผ่านเครือข่ายอินเตอร์เน็ตหรืออินทราเน็ตจะท า

ให้การกระจายสื่อท าได้อย่างรวดเร็ว และกว้างขว้างกว่าสื่อที่อยู่ในรูปสิ่งพิมพ์ (“หนังสือพิมพ์ออนไลน์

นวัตกรรมแห่งส่ืออนาคต”,2541 : 60) 

1.6 สนับสนุนการเรียนการสอนแบบห้องเรียนเสมือนห้องสมุดเสมือนและห้องสมุด

อิเล็กทรอนิกส์ 

1.7 มีลักษณะไม่ตายตัวสามารถแก้ไขปรับปรุงเปลี่ยนแปลงได้ตลอดเวลาอีกทั้งยังสามารถ

เช่ือมโยงไปสู่ข้อมูลที่เกี่ยวข้องได้โดยใช้ความสามารถของไฮเปอร์เท็กซ์ 

1.8 ในการสอนหรืออบรมนอกสถานที่การใช้หนังสืออิเล็กทรอนิกส์จะช่วยให้เกิดความ

คล่องตัวย่ิงขึ้น เนื่องจากสื่อสามารถสร้างเก็บไว้ในแผ่นซีดีได้ไม่ต้องหอบห้ิวสื่อซึ่งมีจ านวนมาก 

1.9 การพิมพ์ท าได้รวดเร็วกว่าแบบใช้กระดาษสามารถท าส าเนาได้เท่าที่ต้องการประหยัด

วัสดุในการสร้างสื่ออีกทั้งยังช่วยอนุรักษ์ส่ิงแวดล้อมอีกด้วย 

1.10 มีความทนทาน และสะดวกต่อการเก็บบ ารุงรักษาลดปัญหาการจัดเก็บเอกสาร

ย้อนหลังซ่ึงต้องใช้เนื้อที่หรือบริเวณกว้างกว่าในการจัดเก็บสามารถรักษาหนังสือหายากและต้นฉบับเขียน

ไม่ให้เสื่อมคุณภาพ 

1.11 ช่วยให้นักวิชาการและนักเขียนสามารถเผยแพร่ผลงานเขียนได้อย่างรวดเร็ว 

             2. ข้อจ ากัดของหนังสืออิเล็กทรอนิกส์ 
ถึงแม้ว่าหนังสืออิเล็กทรอนิกส์จะมีข้อดีที่สนับสนุนด้านการเรียนการสอนมากมายแต่ก็ยังมี

ข้อจ ากัดด้วยดังต่อไปนี้ 

2.1 คนไทยส่วนใหญ่ยังคงชินอยู่กับสื่อที่อยู่ในรูปกระดาษมากกว่า  (“หนังสือพิมพ์ออนไลน์

นวัตกรรมสื่อแห่งอนาคน “, 2541: 60) อีกทั้งหนังสืออิเล็กทรอนิกส์ยังไม่สมารถใช้งานได้ง่ายเมื่อเทียบกับ

สื่อสิ่งพิมพ์ และความสะดวกในการอ่านก็ยังน้อยกว่ามาก 

2.2 หากโปรแกรมสื่อมีขนาดไฟล์ใหญ่มากๆ จะท าให้การเปลี่ยนหน้าจอมีความล่าช้า 

2.3 การสร้างหนังสืออิเล็กทรอนิกส์เพื่อให้ได้ประสิทธิภาพที่ดี  ผู้สร้างต้องมีความรู้ และความ

ช านาญในการใช้โปรแกรมคอมพิวเตอร์และการสร้างสื่อดีพอสมควร 

2.4 ผู้ใช้สื่ออาจจะไม่ใช่ผู้สร้างสื่อฉะนั้นการปรับปรุงสื่อจึงท าได้ยากหากผู้สอนไม่มีความรู้ด้าน

โปรแกรมคอมพิวเตอร์ 

2.5 ใช้เวลาในการออกแบบมากเพราะต้องใช้ทักษะในการออกแบบเป็นอย่างดีเพื่อให้ได้สื่อที่มี

คุณภาพ 
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ประโยชน์ของ E-book 
1. ช่วยให้สามารถย้อนกลับมาอ่านได้และสามารถเลือกอ่านได้ตามเวลา-สถานที่ที่ตนเองสะดวก 

2. การตอบสนองที่รวดเร็วของคอมพิวเตอร์ที่ให้ทั้งสีสัน  ภาพ และเสียง ท าให้เกิดความตื่นเต้น

และไม่เบื่อหน่าย 

3. สามารถปรับเปลี่ยน แก้ไข เพิ่มเติมข้อมูลได้ง่าย สะดวก และรวดเร็ว ให้ทันสมัย 

กับเหตุการณ์ได้เป็นอย่างดี 

4. สามารถค้นหาข้อมูลที่เกี่ยวข้องกับเร่ืองที่ก าลังศึกษา 

ความแตกต่างของหนังสืออิเล็กทรอนิกส์ (e-Book) กับหนังสือทั่วไป 
             ความแตกต่างของหนังสือทั้งสองประเภทจะอยู่ที่รูปแบบของการสร้าง การผลิตและการใช้งาน 

เช่น 

             1. หนังสือทั่วไปใช้กระดาษ หนังสืออิเล็กทรอนิกส์ไม่ใช้กระดาษ (อนุรักษ์ทรัพยากรป่าไม้) 

             2. หนังสือทั่วไปมีข้อความและภาพประกอบธรรมดา หนังสืออิเล็กทรอนิกส์สามารถสร้างให้มี

ภาพเคลื่อนไหวได้ 

             3. หนังสือทั่วไปไม่มีเสียงประกอบ หนังสืออิเล็กทรอนิกส์สามารถใส่เสียงประกอบได้ 

             4. หนังสื่อทั่วไปแก้ไขปรับปรุงได้ยาก หนังสื่ออิเล็กทรอนิกส์สามารถแก้ไขและปรับปรุงข้อมูล 

(update) ได้ง่าย 

             5. หนังสือทั่วไปสมบูรณ์ในตัวเอง หนังสืออิเล็กทรอนิกส์สามารถสร้างจุดเช่ือมโยง (links) ออกไป

เช่ือมต่อกับข้อมูลภายนอกได้ 

             6. หนังสือทั่วไปต้นทุนการผลิตสูง หนังสืออิเล็กทรอนิกส์ต้นทุนในการผลิตหนังสือต่ าประหยัด 

             7. หนังสือทั่วไปมีขีดจ ากัดในการจัดพิมพ์ หนังสืออิเล็กทรอนิกส์ไม่มีขีดจ ากัดในการจัดพิมพ์ 

สามารถท าส าเนาได้ง่ายไม่จ ากัด 

             8. หนังสือทั่วไปเปิดอ่านจากเล่ม หนังสืออิเล็กทรอนิกส์ต้องอ่านผ่านคอมพิวเตอร์ 

             9. หนังสือทั่วไปอ่านได้อย่างเดียว หนังสืออิเล็กทรอนิกส์นอกจากอ่านได้แล้วยังสามารถสั่งพิมพ์ 

(print) ได้ 

             10. หนังสือทั่วไปอ่านได้1 คนต่อหนึ่งเล่ม หนังสืออิเล็กทรอนิกส์ 1 เล่มสามารถอ่านพร้อมกันได้

จ านวนมาก (ออนไลน์ผ่านอินเทอร์เน็ต) 
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             11. หนังสือทั่วไปพกพาล าบาก  (ต้องใช้พื้นที่) หนังสืออิเล็กทรอนิกส์พกพาได้สะดวกคร้ังละ

จ านวนมากในรูปแบบของไฟล์คอมพิวเตอร์ ใน handy drive หรือ CD 

โครงสร้างหนังสืออิเล็กทรอนิกส์ (e-Book Construction) 
             ลักษณะโครงสร้างของหนังสืออิเล็กทรอนิกส์จะมีความคล้ายคลึงกับหนังสือทั่วไปที่พิมพ์ด้วย

กระดาษ หากจะมีความแตกต่างที่เห็นได้ชัดเจนก็คือกระบวนการผลิต รูปแบบ และวิธีการอ่านหนังสือ  

      สรุปโครงสร้างทั่วไปของหนังสืออิเล็กทรอนิกส์ ประกอบด้วย 

             1. หน้าปก (Front Cover) 

             2. ค าน า (Introduction) 

             3. สารบัญ (Contents) 

             4. สาระของหนังสือแต่ละหน้า (Pages Contents) 

             5. อ้างอิง (Reference) 

             6. ดัชนี (Index) 

             7. ปกหลัง (Back Cover) 

             หน้าปก หมายถึง ปกด้านหน้าของหนังสือซึ่งจะอยู่ส่วนแรก เป็นตัวบ่งบอกว่าหนังสือเล่มนี้ช่ือ

อะไร ใครเป็นผู้แต่ง 

             ค าน า หมายถึง ค าบอกกล่าวของผู้เขียนเพื่อสร้างความรู้ ความเข้าใจเกี่ยวกับข้อมูลและเร่ืองราว

ต่างๆ ของหนังสือเล่มนั้น 

             สารบัญ หมายถึง ตัวบ่งบอกหัวเร่ืองส าคัญที่อยู่ภายในเล่มว่าประกอบด้วยอะไรบ้างอยู่ที่หน้าใด

ของหนังสือ สามารถเช่ือมโยงไปสู่หน้าต่างๆ ภายในเล่มได้ 

             สาระของหนังสือแต่ละหน้า หมายถึง ส่วนประกอบส าคัญในแต่ละหน้า ที่ปรากฏภายในเล่ม 

ประกอบด้วย 

                          - หน้าหนังสือ (Page Number) 

                          - ข้อความ (Texts) 

                          - ภาพประกอบ (Graphics) .jpg, .gif, .bmp, .png, .tiff 

                          - เสียง (Sounds) .mp3, .wav, .midi 

                          - ภาพเคลื่อนไหว (Video Clips, flash) .mpeg, .wav, .avi 
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                          - จุดเช่ือมโยง (Links) อ้างอิง หมายถึง แหล่งข้อมูลที่ใช้น ามาอ้างอิง อาจเป็นเอกสาร ต ารา 

หรือ เว็บไซต์ก็ได้ 

             ดัชนี หมายถึง การระบุค าส าคัญหรือค าหลักต่างๆ ที่อยู่ภายในเล่ม โดยเรียงล าดับตัวอักษรให้

สะดวกต่อการค้นหา พร้อมระบุเลขหน้าและจุดเช่ือมโยง 

             ปกหลัง หมายถึง ปกด้านหลังของหนังสือซึ่งจะอยู่ส่วนท้ายเล่ม 

การใช้ Electronic Book เพ่ือการเรียนการสอน 
             E-Book จัดว่าเป็นนวัตกรรมทางการศึกษาในรูปแบบใหม่ที่ก าลังได้รับความสนใจจากนัก

การศึกษาและผู้ที่เกี่ยวข้องกับการจัดการศึกษา Electronic Book จะครอบคลุมหนังสือทั่วๆไปที่จัดท าแล้ว

สามารถอ่านได้ด้วยเทคโนโลยีสารสนเทศต่างๆ ส่วนใหญ่จะใช้คอมพิวเตอร์ในการอ่านมีโปรแกรมในกร

อ่านโดยเฉพาะต าราอิเล็กทรอนิกส์จะเป็น Electronic Book ประเภทหนึ่งที่จ าเป็นต้องน ามาจัดการเกี่ยวกับ

การเรียนการสอนในสังคมการเรียนรู้ในปัจจุบัน 

               ทุกประเทศเห็นความส าคัญในการจัดท า Electronic Book เพื่อประกอบการเรียนการสอนโดย

อาศัยเครือข่ายอินเตอร์เน็ตเป็นตัวช่วยด าเนินการและจัดการให้เกิดระบบการเรียนรู้การจัดการเรียนการ

สอนในยุคแรกๆ ใช้ระบบสื่อสารที่มีอยู่ในขณะนั้น เช่น การจัดการเรียนการสอนทางวิทยุ โทรทัศน์ 

ดาวเทียม แต่ในปัจจุบันใช้ระบบเครือข่ายอินเตอร์เน็ตเป็นสื่อที่ส าคัญในการด าเนินการ ใช้โปรแกรม

คอมพิวเตอร์ในการจัดท า Electronic Book อาจเป็นโปรแกรมที่พัฒนาเองหรือใช้ภาษา HTML ในการเขียน

หรือใช้โปรแกรมส าเร็จรูปอื่นๆ ช่วยเขียนขึ้นกลายเป็นโปรแกรมช่วยสอนในลักษณะต่างๆ โปรแกรมที่

นิยมใช้ในการน ามาจัดการเรียนการสอนในสถาบันการศึกษาต่างๆในขณะนี้ได้แก่ โปรแกรม  Blackboard, 

Syllas, Education Sphere,Advance Vision, Exam Cybernet, WebCT และ  MediaSTAQ เป็ น ต้ น  มี ก าร

พัฒนาโปรแกรมเพื่อน ามาจัดการเกี่ยวกับการเรียนการสอนมากมาย บางบริษัทด าเนินการให้บริการทั้งการ

ติดตั้งที่สถานที่ศึกษาและให้บริการในระบบอินเตอร์เน็ต ส่วนในประเทศไทยเร่ิมใช้การเรียนการสอน

อิเล็กทรอนิกส์ในสถานศึกษา มหาวิทยาลัยเปิดจะได้เปรียบในการใช้การเรียนการสอนอิเล็กทรอนิกส์

เพราะสามารถตอบสนองความต้องการของผู้เรียนโดยไม่มีข้อจ ากัดต่างๆ ในเร่ืองของความไม่พร้อมของ

ผู้เรียน ระยะทางของการมาเรียนหรือเวลาที่จะต้องเรียน 
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โปรแกรมที่ใช้ในการสร้าง multimedia authoring 
               โปรแกรมที่ใช้ในการผลิตงานมัลติมีเดีย มีกี่ประเภท อะไรบ้าง และมีหลักเกณฑ์ในการแบ่ง

อย่างไร 

               โปรแกรมที่ใช้ในการผลิตงานมัลติมีเดียสามารถแบ่งได้ดังนี้ คือ 

               1. เทคโนโลยีเกี่ยวกับเสียง (Audio Technology) ซึ่งรวมทั้งเสียงพูด และเสียงดนตรีตั้งแต่การ

ประมวลผล การแสดงผล การจัดการต่างๆ เช่น การบีบอัดสัญญาณ การสื่อสาร การส่งสัญญาณ 

               2. เทคโนโลยีเกี่ยวกับวีดิโอ (Video Technology) อันได้แก่ การจัดเก็บการประมวลผล การ

ปรับแต่ง การใช้งาน การเรียกหา สืบค้น การส่งกระจาย มาตรฐานการบีบอัดสัญญาณ การเข้าและถอดรหัส 

การส่งข้อมูล การท างานร่วมกับสื่ออื่นๆ 

               3. เทคโนโลยีรูปภาพ (Image Technology) เป็นการพัฒนา และประยุกต์ใช้ภาพการจัดการ

ฟอร์แมต คลังภาพ การค้นหา การสร้าง และตกแต่งภาพ 

               4. เทคโนโลยีข้อความ (Text Technology) เกี่ยวกับข้อความหรือ ตัวอักษร ทั้งการใช้ และลักษณะ

รูปแบบของ ข้อความแบบต่างๆ 

               5. เทคโนโลยีภาพเคลื่อนไหว และภาพสามมิติ (Animation & 3D Technology) เป็นเทคโนโลยี

เกี่ยวกับการแสดงผล ด้นภาพเคลื่อนไหว ทั้งแบบ 2 มิติ และ 3 มิติ การสร้างภาพเสมือนจริง (VR - Visual 

Reality) การสร้าง ตกแต่ง ประมวลผล การใช้งาน 

               6. เทคโนโลยีการพัฒนา (Authoring System Technology) คือ เทคโนโลยีที่ได้พัฒนาเพื่อสร้าง

เคร่ืองมือส าหรับ งานพัฒนามัลติมีเดีย ในรูปของซอฟต์แวร์ช่วย ในการน าข้อมูล เนื้อหา(Content) เข้าไป

เก็บตามสื่อรูปแบบต่างๆ ที่วางไว้ เพื่อน าเสนอ เช่น การใช้เครื่องมือต่างๆ หรือการสร้างเครื่องมือใหม่ๆ 

               7. เทคโนโลยีกับระบบการศึกษา เป็นการศึกษาเพ่ือน าเอา เทคโนโลยีมัลติมีเดีย มาประยุกต์ใช้กับ 

ระ บ บ ก ารศึ ก ษ า  ใน รูป ข อ ง  CAI – Computer Aided Instruction, CBT - Computer Based Training 

ตลอดจนงานประชาสัมพันธ์ โฆษณา สร้างภาพยนตร์ 

               8. เทคโนโลยีการผลิต (Publishing Technology) เป็นการน าเอามัลติมีเดีย มาใช้ด้านงานพิมพ์ เพื่อ

เพิ่มชีวิตชีวาให้กับงานพิมพ์ มีรูปแบบที่โดดเด่น และน าเสนอ หรือพิมพ์ลงสื่อได้หลากรูปแบบ เช่น งาน 

DTP - Desktop Publishing, CD-ROM Title & Publishing 

               9. เทคโนโลยีการกระจาย (Broadcasting & Conferencing) ส่งเกี่ยวข้องกับการเผยแพร่ข้อมูล 

เผยแพร่สัญญาณ เช่น Conference, Multicasting Backbone เป็นต้น 
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               10. เทคโนโลยีการจัดเก็บข้อมูล (Storage Technology) เนื่องด้วยข้อมูลด้านมัลติมีเดีย มักจะมี

ขนาดโต ท าให้ต้องเกี่ยวข้องกับสื่อบันทึกข้อมูลอย่างหลีกเลี่ยงไม่ได้ ทั้งเกี่ยวกับรูปแบบของสื่อ รูปแบบ

การบีบอัดข้อมูล รูปแบบการบันทึกข้อมูล 

               11. เทคโนโลยี WWW & HyperText โดยจะช่วยให้เกิดการเผยแพร่สื่อมัลติมีเดียในรูปแบบที่

นิยมมากที่สุด และเร็วที่สุด ผ่านระบบ WWW และมีระบบโต้ตอบด้วยเทคโนโลยี  HyperText & 

HyperMedia 

               12. เทคโนโลยีคลังข้อมูล (Media Archives) ซึ่งเกี่ยวกับการจัดเก็บข้อมูลปริมาณมากๆ และการ

เรียกค้นภายหลัง เช่น Photo & Image Server, AVI archives 

ประโยชน์ของมัลติมีเดีย 
               ปัจจุบันนี้สื่อมัลติมีเดีย ได้เข้ามามีบทบาทในชีวิตของคนเรามากย่ิงขึ้น โดยมีประโยชน์ ดังนี้ 
               1. มีการประยุกต์ใช้มัลติมีเดียในการสร้างสื่อการเรียนการสอน อันส่งผลให้เกิดระบบห้องสมุด
แบบดิจิทัล (Digital Library) การเรียนการสอนทางไกล (Distance Learning) การสร้างห้องเรียนเสมือนจริง 
(Virtual Classroom) และการเรียนการสอนแบบกระจาย อันส่งผลให้เกิดการเรียนรู้อย่างกว้างขวาง 
               2. ในส่วนของภาคธุรกิจ โดยเฉพาะธุรกิจรูปแบบใหม่ที่เรียกว่า  E-Commerce อันจะช่วยให้การ
น าเสนอสินค้า มีความน่าสนใจมากกว่าเดิมธุรกิจการพิมพ์ นับเป็นอีกหนึ่งธุรกิจที่สัมพันธ์กับเทคโนโลยี
มัลติมีเดีย อันจะส่งผลให้หนังสือสิ่งพิมพ์ต่างๆ มีความน่าสนใจมากขึ้น และปัจจุบันก็มี E - Magazine หรือ 
E - Book ออกมาอย่าง 
               3. ธุรกิจการให้บริการข้อมูลข่าวสาร เมื่อมีการน าเทคโนโลยีมัลติมีเดียมาช่วย จะท าให้ข้อมูล
ข่าวสารที่เผยแพร่ออกไป มีความน่าสนใจมากกว่าเดิมธุรกิจโฆษณา และการตลาด มีการใช้มัลติมีเดียเข้ามา
ช่วยในการสร้างสื่อโฆษณา ซึ่งจะช่วยดึงดูดคนเข้ามาชม ด้วยเทคโนโลยีใหม่ๆ ที่มีความแปลกใหม่ 
               4. การแพทย์และสาธารณสุข ปัจจุบันมีการสร้างส่ือเรียนรู้ด้านการแพทย์ ช่วยให้ประชาชนทั่วไป
มีความสนใจศึกษา เพื่อสร้างความเข้าใจที่ถูกต้องเกี่ยวกับการดูแล รักษาสุขภาพตนเอง 
               5. นันทนาการ นับเป็นบทบาทที่ส าคัญมาก ทั้งในรูปของเกมการเรียนรู้ 
               6. มีการประยุกต์ใช้ Virtual Reality เพื่อให้เกิดประโยชน์ในด้านต่างๆ มากย่ิงขึ้น 

การเลือกใช้สีในหนังสือ E-book 
        ก าหนดสีที่ใช้ 
               1. โทนสีเดียว 
               2. โทนสีผสม 2 สี 
               3. โทนสีผสม 3 สี 
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               4. Color scheme, theme 
               5. ดูสีของส่ิงพิมพ์, logo หัวจดหมาย หรือสื่อโฆษณา ประชาสัมพันธ์อื่นๆ ที่มีอยู่ของบริษัท 

โปรแกรมที่นิยมใช้สร้างสื่อ E – book 
          โปรแกรมที่นิยมใช้สร้าง e-Book มีอยู่หลายโปรแกรม แต่ที่นิยมใช้กันมากในปัจจุบัน ได้แก่ 
               1. โปรแกรม Flip Album 
               บทเรียน e-book ที่สร้างด้วยโปรแกรม FlipAlbum จะมีลักษณะการแสดงผลคล้ายหนังสือจริง ๆ 
และภายในเล่มยังสามารถบรรจุข้อมูลในลักษณะ Multimedia ได้ด้วย กล่าวคือ สามารถมีได้ทั้งข้อความ 
(text) รูปภาพ (Image) ภาพเคลื่อนไหว ( Movie) และเสียง (Audio) ซึ่งสามารถเอื้ออ านวยให้การจัดท า
บทเรียนมีความสมบูรณ์และตอบสนองต่อการเรียนรู้ได้ดีและสร้างย่ิงขึ้น ทั้งยังสามารถเช่ือมโยง (Link) 
ออกไปสู่แหล่งข้อมูลในภาพอินเตอร์เน็ตได้ด้วย หากครูผู้สอนมีความรู้ความสามารถในการสร้าง e-book 
ด้วยโปรแกรมดังกล่าวก็จะช่วยให้สามารถพัฒนาสื่อการเรียนรู้ได้ด้วย ตนเองอย่างน่าสนใจ น าไปใช้ในการ
เรียนการสอนให้เกิดประสิทธิภาพและประสิทธิผลมากย่ิงขึ้น 

 

          หนังสืออิเล็กทรอนิกส์ที่สร้างด้วยโปรแกรม Flip Album นั้น จะต้องติดตั้งโปรแกรมตัวอ่านก่อน คือ 
Flip Viewer (ติดตั้งเพียงคร้ังเดียว) โปรแกรมสร้าง eBook ตระกูล Flip Album มีความน่าสนใจมากทีเดียว 
เพราะสามารถสร้างผลงานง่ายและรูปร่างหน้าตาใกล้เคียงกับหนังสือหรือ Album 3 มิติจริงๆ สามารถ
แทรกเพลง, ภาพ, ภาพเคลื่อนไหว ฯลฯ ตลอดจนพัฒนาเป็นสื่อได้ทั้งแบบออฟไลน์และออนไลน์ผ่าน
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อินเทอร์เน็ต หากจะมีข้อจ ากัดคือไม่สามารถ save เป็นไฟล์ .exe, หรือไฟล์ที่สามารถน าไปเปิดอย่างอิสระ
ได้ จ าเป็นจะต้องเปิดด้วยโปรแกรม FlipAlbum หรือโปรแกรม Flip Viewer ที่ติดตั้งไว้ในเครื่องเท่านั้น 

ตัวอย่างหนังสือที่สร้างด้วยโปรแกรม Flip Album 
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      2. โปรแกรม Desktop Author 

 

ในปัจจุบันการเรียนการสอนสามารถที่จะเรียนรู้ได้ด้วยตนเองโดยผ่านทางสื่อต่าง ๆโดยเปลี่ยน
จากหนังสือหรือเอกสารทั่ว ๆ ไปมาเป็นการเรียนการสอนแบบ  E-learning, e-bookหรือใช้สื่ออื่น ๆ ที่
เกี่ยวข้องเข้ามาช่วยท าให้มีการพัฒนากระบวนการเรียนการสอนให้น่าสนใจมากย่ิงขึ้น 

 

โปรแกรม Desktop Author เป็นโปรแกรมที่ใช้ส าหรับสร้างสื่อดิจิตอล หรือที่เรียกทั่วๆ ไปว่า “ E-
Book ” เอกสารที่ได้จาการสร้างด้วยโปรแกรม  Desktop Author นี้ จะมีลักษณะรูปร่างเหมือนหนังสือ 
ทั่วไป คือมีปกหน้า สารบัญ ข้อความ รูปภาพ และนอกจากนี้ยังสามารถที่จะแทรกภาพเคลื่อนไหว ไฟล์
ภาพยนตร์ ไฟล์ flash และเสียงบรรยาย ลงไปในหนังสือได้ 

โปรแกรม Desktop Author เป็นโปรแกรมที่ใช้ส าหรับการสร้าง e-book โดยมีจุดเด่นที่ความง่ายใน
การใช้งาน สามารถสร้าง e-book ได้อย่างรวดเร็ว นอกจากนี้ e-book ที่ท าด้วยโปรแกรมนี้ยังสามารถเปิดดู
ในเคร่ืองคอมพิวเตอร์ เคร่ืองไหนก็ได้โดยที่ไม่จ าเป็นต้องมีโปรแกรม  Desktop Author ในเครื่องที่เปิดอยู่
ได้ 
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ข้อดีของโปรแกรม Desktop Author 
1. ไฟล์ที่ได้จากการ Export มีขนาดเล็ก 
2. มีลักษณะคล้ายกับหนังสือ สามารถสั่งพิมพ์ในแต่ละหน้าหรือทั้งหมด 

ของหนังสือได ้
3. สามารถเผยแพร่ผ่านระบบเครือข่ายได้ง่าย และ Download ผ่านเว็บ 

ได้รวดเร็ว หรือสามารถที่จะส่งไฟล์ผ่านทางจดหมายอิเล็กทรอนกิส์ ( E-Mail) ได ้
 

ตัวอย่างหนังสือทีส่ร้างด้วยโปรแกรม Desktop Author 

 

 

 

 

 

 

 
 

 



 

 

บทที่ 2 
การติดตั้งและใช้งานโปรแกรม 

การติดต้ังโปรแกรม Desktop Author 7.1.5 
    การติดต้ังโปรแกรม มีขั้นตอนดังนี ้
1. ไปยังต ำแหน่งที่เก็บไฟล์ติดตั้งโปรแกรม Desktop Author จะปรำกฏไฟล์ที่ใช้ในกำร ติดตั้ง ดังภำพ 

 
2. ติดตั้งโปรแกรมโดยกำรดับเบิ้ลคลิกที่ไฟล ์DTAPRO715setup จำกนั้นจะปรำกฏหน้ำต่ำง 
ต้อนรับกำรติดตั้งโปรแกรม ให้คลิกปุ่ม Next > 

 
 
3. จำกนั้นจะปรำกฏหน้ำต่ำงลิขสิทธ์ิโปรแกรม ให้คลิกเลือก ._ I accept the license 
agreement เพื่อยอมรับลิขสิทธ์ิ จำกนั้นคลิกปุม่ Next > 
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4. เมื่อปรำกฏหน้ำต่ำงช่ือผู้ใช้งำนให้คลิกปุ่ม Next > ผ่ำนไปเลย 
5. จำกนั้นจะปรำกฏหน้ำต่ำงต ำแหน่งกำรติดตั้งของโปรแกรม โดยโปรแกรมจะถูกติดตั้ง 
ไว้ที่ C:\Program Files\DeskTopAuthor\ ให้คลิกปุ่ม Next > ผ่ำนไปอกีครั้ง 
6. จำกนั้นจะปรำกฏหน้ำต่ำงเกี่ยวกับกำร Update โปรแกรมให้คลิกปุ่ม Next > 
7. โปรแกรมจะเร่ิมติดตั้งโดยกำรคัดลอกไฟล์ตำ่งๆ ลงในเครื่อง ให้รอจนกว่ำกำรติดตั้ง 
จะแล้วเสร็จ 

 
8. จำกนั้นจะปรำกฏหน้ำจอเสร็จสิ้นกำรติดตั้งโปรแกรมแสดงว่ำกำรติดตั้งโปรแกรม 
เรียบร้อยแล้ว ให้คลิกปุ่ม Finish เพื่อเสร็จสิ้นกำรติดตั้งโปรแกรม 
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บทที่ 3 
การใช้งานโปรแกรม Desktop Author 

หลังจากที่ได้ท าการติดตั้งโปรแกรม Desktop Author ซึ่งเป็น Version 7.1.5 ลงใน 
คอมพิวเตอร์เรียบร้อยแล้ว จะมี Icon ของโปรแกรมอยู่ที่ Desktop เราสามารถจะเรียกใช้ได้โดย 
ดับเบิลคลิก ที่ Icon 

 
 
หรือจะเรียกใช้จาก  Window 8  >  กดปุ่ม                  ที่ Keyboard > พิมพ์    DesktopAuthor >         
 

 
 

โปรแกรมจะเปิดหน้าแรกขึ้นมาให้เราดังรูป 
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ส่วนประกอบของโปรแกรม 

1. เมนูและทูลบาร ์( Menu & Toolbar ) เป็นปุ่มใช้งานทั่ว ๆ ไป  

 
 
แต่ละปุ่ม มีหน้าที่ดังนี้ 

 
ใช้ส าหรับสร้างงานใหม่ 

 

ใช้ส าหรับการเปิดงานที่มีอยู่แล้วขึ้นมาดู
หรือแก้ไข 

 

ใช้ส าหรับบันทึกงานที่ได้จัดท า
ขึ้น  

ใช้ส าหรับดูตัวอย่าง ( Preview ) งานที่ได้
ท า 

 

ใช้ส าหรับเก็บไฟล์ทั้งหมดที่ท า
ขึ้นมาให้เป็น ไฟล์เดียวอยู่ในรูป
ของ .EXE  

ใช้บีบอัดไฟล์งานทั้งหมดที่ท าขึ้นมาให้
เป็นไฟล์เดียวอยู่ในรูปของ .DNL ส าหรับ
การท าเวปไซต์ 

 

ใช้ส าหรับป้องกันไฟล์งาน
ทั้งหมดที่ท าขึ้นมาเพ่ือน าเสนอ
ในเวปไซต์ไฟล์เดียวโดยมี
นามสกุล .DRM 

 
ใช้ในการท า Screen saver 

 
ใช้ส าหรับใส่ไฟล์ DNL ลง
ในเวปไซต์  

ใช้ส าหรับ upload ไฟล์ขึ้นเวปไซต์ 

 
ใช้ เปิดไฟล์ .epub ของ Android 

 
ใช้ส าหรับการแทรกค าถาม ค าตอบ และ
เพิ่ม Object ลงใน e-book 

 
ใช้ส าหรับ refresh งาน 

 
ใช้ส าหรับตั้งค่าต่าง ๆ ของ e-book 

 
ใช้ส าหรับเลือกรูปแบบต่างๆ
เป็นต้นแบบที่จะน ามาสร้างเป็น
e-book 

 
ใช้ส าหรับการเลือกปุ่มเพื่อแทรกลงในe-
book 
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2. แถบเครื่องมืออื่น ๆ เป็นแถบเครื่องมือที่ใช้ส าหรับการจัดการในหนังสือ ที่ใช้บ่อย ๆ 
แบ่งออกเป็น 5 ส่วน คือ 

ส่วนที ่1 Page เป็นเคร่ืองมือที่ใช้ส าหรับการจัดการเกี่ยวกับหน้าของหนังสือ เช่น เพิ่ม 
หน้า ลบหน้า เป็นต้น  

 

 ( Add Page ) ส าหรับเพิ่มหน้าเอกสาร  

 ( Delete Page) ส าหรับลบหน้าเอกสาร 

 ( Move Page ) ส าหรับย้ายหน้าเอกสาร 

 ( Copy Page ) ส าหรับคัดลอกหน้าเอกสาร 

 ( Previous Page ) แสดงเอกสารหน้าก่อนหน้า 

 ( Next Page ) แสดงเอกสารหน้าถัดไป 

 (Goto Page) ก าหนดเลือกหน้าเอกสาร 

 
(Insert/delete multiple pages) ก าหนด สร้าง ลบเอกสาร 
 แบบ multiple pages 

 
ส่วนที ่2 Insert เป็นกลุ่มเครื่องมอืที่ใช้งานเกี่ยวกับการแทรก วัตถุต่าง ๆ เข้ามาไว้ใน หนังสือ เช่น แทรก
กล่องขอ้ความ แทรกรูปภาพ เป็นต้น 

 

 ( Insert Box ) แทรกกล่องสีให้หน้าเอกสาร  

 ( Insert Image) แทรกรูปภาพ 

 ( Insert Text ) แทรกข้อความ 

 ( Insert Editable Text ) ส าหรับแก้ไขข้อความ 

 (Insert Editable Image) ส าหรับแก้ไขรูปภาพ 

 ( Popup Image ) ใส่ข้อความโดยใช้ Text Block 

 (Insert updateble text) แก้ไขข้อความพิเศษ 

 (Insert updateble image) แก้ไขไฟลม์ัลติมีเดีย 

 (Insert multi-page text flow) สร้างเพจหลายอันในหน้าเดียว  

 (Insert Multimedia) แทรกไฟล์มัลตมิีเดีย 
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ส่วนที ่3 Edit เป็นกลุ่มเครื่องมอืที่ใช้เกี่ยวกับการแก้ไขทั้งหมด เช่น การตัด คัดลอก หรือ การลบ เป็นต้น 
 

 

 ( Undo ) ยกเลิกค าสั่งปัจจุบัน  

 ( Redo) กลับไปท างานตามค าสั่งที่ยกเลิกไป 

 ( Cut ) ตัดวัตถุ 

 ( Copy ) คัดลอกวัตถ ุ

 ( Paste ) วางวัตถุที่คัดลอกมา 

 ( Delete ) ลบวัตถุทิ้ง 

 (Paste on multiple pages) วางเอกสารหลายหน้า 
 
ส่วนที ่4 Change เป็นกลุ่มเครื่องมือที่ใช้เกี่ยวกับการเปลี่ยนแปลงค่าต่าง ๆ เช่น การ เปลี่ยนจุดเช่ือมโยง การ
เปลี่ยนรูปภาพ เป็นต้น 

 

 ( Change Scale ) ตั้งค่าขนาดของวัตถ ุ

 ( Change Link) เปลี่ยนการเช่ือมโยงวัตถุ  

 ( Change Position ) ย้ายวัตถุต่าง ๆ บนหน้ากระดาษ 

 ( Change Image ) ส าหรับเปลี่ยนรูปภาพ 

 ( Change Transparency ) แก้ไขความคมชัดของรูปภาพ 

 ( Edit Image ) เรียกใช้ Image Editor 
 
ส่วนที ่5 Colour เป็นกลุ่มเครื่องมือเกี่ยวกับการก าหนดสี และขอบส ีเป็นต้น 

 

 ( Border Colour ) ก าหนดสีขอบวัตถ ุ

 ( Fill Colour ) ก าหนดสีของวัตถ ุ

 
1. แถบเครื่องมือที่ใช้ในการจัดวางวัตถุ 
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 ( Send to top ) ให้วัตถุอยู่บนสุด   ( Up one layer ) ให้วัตถุอยู่สูงขึ้นไปอีกระดับ
หนึ่ง 

 ( Down one layer )ให้วัตถุอยู่ช้ันต่ าลงไป
อีกระดับหนึ่ง 

 ( Send to buttom )ให้วัตถุอยู่ช้ันล่างสุด 

 ( Align left ) ให้วัตถุอยู่ชิดด้านซ้าย  ( Align right ) ให้วัตถุอยู่ชิดด้านขวา 

 ( Align center vertical ) ให้วัตถุอยู่ตรง
กลางในแนวตั้ง 

 ( Align top ) ให้วัตถุอยู่ชิดด้านบน 

 ( Align Buttom ) ให้วัตถุอยู่ชิดด้านล่าง 
 

 ( Align center horizontal ) ให้วัตถุอยู่ตรง
กลางใน แนวนอน 

 ( Distribute Width ) ให้วัตถุอยู่กึ่งกลางใน
แนวนอน 

 ( Distribute Height ) ให้วัตถุอยู่กึ่งกลางใน
แนวตั้ง 

 
ล าดับขั้นการสร้างหนังสือ 

เปิดโปรแกรม Desktop Author ขึ้นมาแล้วคลกิเลอืก New หรือ File > New 

หรือ        

จะมีหน้าต่างให้เรา ก าหนดค่า Properties ต่าง ๆ ของ E – Book ดังรูป 
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ความหมายของค่าต่าง ๆ จาก Book Properties มีดังนี ้
Width : ความกว้างของหนังสือ 
Height : ความสูงของหนังสือ 
Border Color : สีเส้นขอบของหนังสือ ในที่นี้เลือก No Border คือไม่ใส่ขอบหนังสือ 

Paper Colour : เลือกสีของแผ่นกระดาษ 

Mask Colour : เลือกสีที่ใช้ในการท ารูปให้โปร่งใส 
Background Colour : สีพ้ืนหลัง 
Character Set : เลือกภาษาที่ใช้ ให้เลือก THAI 
Text default left : ความห่างของกลอ่งข้อความกบัขอบกระดาษซ้ายมือ 
Text default top : ความห่างของกล่องขอ้ความกบัขอบกระดาษด้านบน 
Text default height : ความสูงของกลอ่งข้อความ 
Text default width : ความกว้างของกล่องข้อความ 
Start with tooltip auto update : เปิดหนังสือพร้อมอัปเดทเครื่องมือ 
Autostart : เปิดหนังสือโดยให้เปิดหน้าเองอัตโนมัติ 
Start with background windows : เปิดหนังสือพร้อมฉากหลัง 
Disable Print Function : จะให้สามารถ print e-book ได้หรือไม ่
Page Turn : ปรับค่าการเปลี่ยนหน้ากระดาษ 
Fly speed : ปรับความเร็วในการเปลี่ยนหน้า 
Start Status : เลือกตั้งค่าให้มีเมนูหรือไมม่ีเมนูบนหนังสือ 
DWB Goto : เลือกการใช้ style ของโปรแกรม 
Default Unicode Value : เลือกใช้ Unicode พื้นฐาน 
With/Without Password : เลือกการใส่หรือไม่ใส่ password ให้กับหนังสือ 
Book Password : ใส่ password กรณีที่ต้องการ 
Book Backup Files : เลือกตั้งค่าไฟล ์back up ว่าจะให้มีกี่ไฟล ์
Disable Send Mail Function : ตั้งค่าการส่ง E-mail 
Disable Save As Function :การบันทึกไฟล ์
Book Transparency : ตั้งค่าเกี่ยวกับการโปร่งใส ในการท าปกหนังสือ 
Book DRM : ตั้งค่าการป้องกันต่างๆ 
Book Email : ตั้งค่า E-mail ส าหรับหนังสือ 
Book Multimedia : ตั้งค่ามัลติมีเดีย ( version ของ Windows Media Player ) 
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การแบ่งหน้ากระดาษออกเป็น 2 ส่วน จากตัวอย่างเราก าหนดค่าหนังสืออยู่ที่ 960 x 670 ให้น าเมาส์ไปช้ีที่
แถบ ไม้บรรทัดด้านบนตรงจุดกึ่งกลางของหนังสือแล้วคลิก 1 ครั้ง จะได้เส้นแบ่งหน้ากระดาษออกมา ดัง
ตัวอย่าง 

 
การใส่สันหนังสือแบ่งหน้าเอกสารออกเป็น 2 ส่วน โดยใช้ Buttons > Dividers 

 
จะมี Dialog Box ขึ้นมาให้เลือกรูปแบบของตัวแบ่งหน้ากระดาษ แล้วกด Use 
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น ามาจัดไว้กึ่งกลางของหน้ากระดาษ (เราจะไม่แบ่งหน้ากระดาษ หรือจะหารูปอื่นมาเป็นตัวแบ่งแทนก็ได)้ 

 
การใส่รูปภาพเพื่อท าปก เลือกที่กล่องเครื่องมอื Insert หรือจะเลือกที ่Insert > Image ก็ได ้

 
จะปรากฏ Dialog Box ขึ้นมาให้ท าการเลือกภาพ โดยคลิกภาพที่ต้องการ แล้วคลิก ปุ่ม Open 
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ได้รูปที่ต้องการแล้วก็ใส่ลงไปในหนังสือได้เลย ปรับขนาดและปรับต าแหน่งภาพตามความเหมาะสม 

 
 

 
 
การใส่ตัวอักษรลงในตัวหนังสือ เลือกที่กล่องเครือ่งมือ Insert หรือจะเลือกที่ Insert > Text ก็ได้จะ 
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จะปรากฏ Dialog Box ขึ้นมาให้ท าการเลือก ฟอนท์ตัวอักษร (1) Thai เลือกลกัษณะตัวอักษร (2) MS san 
serif และเลือกสี่ตัวอกัษร (3) พิมพ์ตัวหนังสือลงในช่องพิมพ์(4)แล้วจัดรูปแบบตามต้องการและกด OK 

 
 

 
 

การก าหนดหน้าหนังสือด้านซ้ายมือมองไม่เห็น เลือกทีก่ล่องเครื่องมอื Insert Box หรือ เมน ูInsert > Box 
เพื่อเลือกส ีแล้วคลิกปุ่ม OKจากนั้นให้เลือกที่กลอ่งเครื่องมือ Insert Box หรือเลือกที่เมน ูInsert > Box 
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จะปรากฏ Dialog Box สีขึ้นมาให้เราเลือกสีเดียวกับที่เราได้ก าหนดไว้ใน Transparent Color 

 
 

แล้วจัดวางต าแหน่ง Box สี ให้ครอบคลุ่มพื้นที่หน้าหนังสือด้านซ้ายให้หมด 
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การก าหนดค่าให้หน้าปกฝ่ังซ้ายมือหายไปโดยการเลือก Tools > Book Transparency 

 
ที่หัวข้อ Eazy Cover Shape ให้ใส่เคร่ืองหมายถูกหน้า With Transparency แล้วเลือก Select ดังรูปเพื่อเลือกส ี

 
 

แล้วกดปุ่ม OK 
* ที่หัวข้อ Eazy Back Cover Shape(ปกหลัง) ต้องท าการเพิ่มหน้าก่อนจึงจะสามารถคลิกเลือกสีได้ 
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การเพิ่ม/ลบหน้าหน้าหนังสือ 

 
1 : ใช้ในการเพิ่มหน้าหนังสือ 
2 : ใช้ในการลบหน้าหนังสือ 
3 : ใช้ในการแทรกหน้าหนังสือ 
4 : ย้อนไปหน้าก่อนหน้า 
5 : เปิดไปหน้าถัดไป 
เซฟไฟล์ต้นฉบับคลิกที่เมนูบาร์ File  >> Save as เลือกโฟลเดอร์ปลายทางและก าหนดช่ือแฟ้มงาน คลิกSave 
 
- ท าการ Insert Text แล้วพิมพ์ข้อมูลที่จะจัดท าสารบัญ 
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- ให้ท าการมาร์กบรรทัดที่ต้องการท าลิ้ง และคลกิที่ปุ่ม Link ด้านล่าง ดังตัวอย่าง 

 
- ในการส่ังเปิดลิ้งไปยังหน้าต่าง ๆ ให้ใช้ค าสั่ง Page แล้วเลือกหมายเลขหน้าที่จะให้เปิด แล้วคลิก OK 
แล้วจะปรากฏเส้นขีดทับบรรทัดที่ได้ท าการลิ้งเรียบร้อยแล้ว 
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- ในการส่ังลิ้งไปยังหน้าต่าง ๆ ให้เช็คสถานะหมายเลขหน้าที่ด้านล่างของโปรแกรมจะบอกเลขหน้าที่ 
ก าลังท างานอยู่ 

 
 
การสร้างปุ่มเมนูต่าง ๆ และการเชื่อมโยงค าสั่งต่าง ๆ 
        1. การท าปุ่มเมนูต่างๆ เพื่อใช้ในการเช่ือมโยงไปยังที่ต่างๆ ตามต้องการ โดยการเลือกที่ แถบเครื่องมือ 
Buttons ซึ่งมีให้เลือกหลายฟังก์ช่ัน 
         ตัวอย่าง การท าปุ่ม Close เพื่อใช้ในการออกจากการดูหนังสือ หรือ ปิดหนังสือนั่นเอง 
เลือกที ่Buttons > Close 

 
จะปรากฏ Dialog Box ขึ้นมาให้เลือกรูปแบบ 

 
 

เสร็จแล้วจัดวางต าแหน่งให้เรียบร้อย หรือหากไม่ชอบรูปแบบที่ให้มานั้น ก็สามารถ Insert 
รูปของเรามาแทนได ้
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2. การส่ังงานให้ปุ่ม Close สามารถใช้งานโดยการ คลิกที่ตัวรูปภาพปุ่ม แล้วเลือกกลอ่ง เครื่องมือ

Change หรือ คลิกขวาที่รูปภาพปุ่มแล้ว เลือก Change Link 

 
 

จากนั้นจะปรากฏ Dialog Box ขึ้นมาให้เลือกคา่ตา่งๆ ขณะนี้เราท าปุ่ม Close หรือ ปุ่มปิด 
ให้เลือกค่าที่ Close Window 

 
หมายเหตุ เราสามารถใส่ปุ่มเพ่ิมเติมเพื่อเช่ือมโยงไปยังที่ต่างๆ ได้หลายอย่างเช่น ไปยังหน้า

เอกสารต่างๆ ที่ต้องการไปยังเว็บไซด์ หรือการส่ังให้พิมพ์เอกสาร ส่งเมล์ เป็นต้น 
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การแทรก File Multimedia 
1. ไฟล์ที่สามารถแทรกได ้File Multimedia ได้แก่ 

- Flash   .swf 
- Movie   .avi , .mpg 
- Sound   .mid , .mp3 

2. การน าไฟล์มัลตมิีเดีย ประกอบด้วยภาพ ภาพเคลื่อนไหว สีและเสียงเร่ิมต้น ผู้ใช้ต้องเตรียมพื้นที่ไว้ 
3. การแทรกไฟล์มลัติมีเดียให้คลิกเมนู Insret > Multimedia หรือ คลิกไอคอน  

4. คลิกปุ่ม Select    Multimedia เพื่อเลือกไฟลม์ลัติมีเดีย 

 

5. ก าหนดค่าการแสดงผล แล้วคลิก OK 
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6. ขยายพื้นที่แสดงผลและจัดรูปแบบตามต้องการ 
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การสร้าง Popup Image 

Popup Image คือ การแสดงรูปภาพที่มีรายละเอียดหรือคุณลักษณะทีม่ากไปกว่าเดิมจากการมองเห็น
ปกติใช้ค าสั่ง Insart > Popup image 

 
ขั้นตอนการท า Popup image 
1. แทรกรูปภาพลงในหนังสือ ซึ่งกรณีนี้จะเป็นรูปภาพที่เล็ก 
2. คลิกเมน ูInsart > Popup image 

 
3. จะปรากฏหน้าต่าง Popup image Dialog 
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4. เลือกภาพให้ตรงกับภาพเล็กที่แสดงอยู่ โดยคลิกที่ปุ่ม Select Popup Image แล้วคลิกปุ่ม OK 

 
จากนั้น ให้ก าหนดพื้นที่ของภาพ โดยกรอบสี่เหลี่ยม ล้อมรอบภาพ 

 

แล้วคลิกไอคอน  เพื่อแสดงผลตัวอย่าง 

1. ท าการเพิ่มหน้าหนังสือเปล่าขึ้นมา และ Insert Text ตกแต่งหน้ากระดาษให้เรียบร้อย 
2. เร่ิมต้นสร้างค าถามโดยไป click ที่ Icon ช่ือ EazyForm บน Icon bar  
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3. หลังจากนั้นจะปรากฏเมนูให้เลือกกดปุม่ Add Question บน เมนูบาร์ Add form objects 
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4. จะปรากฏหน้าจอสร้างข้อสอบ ในส่วน Answer > Type ก าหนดเป็น RadioBox เพื่อท าข้อสอบแบบ 
ช้อย และก าหนดตัวเลือกค าตอบ ในตัวอย่างก าหนด 4 ตัวเลือก 

 

5. ในการสร้างข้อสอบจะต้องมีการก าหนดรูปแบบตัวอักษรที่จะใช้ ในตัวอย่างจะยกตัวอย่างการก าหนด 
เป็น Style เพื่อให้สะดวกในการท างานข้อต่อ ๆ ไป โดยในส่วนของ Select Style Settings ให้คลิกเลือก 
Edit เพื่อก าหนดค่าต่าง ๆ ดังรูป 

 

 

 

ก าหนดข้อความในหน้าเฉลย 
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ในส่วนของ Question 
Font : ให้เลือกลักษณะตัวอักษรที่ต้องการ 
Text Colour : เลือกสีตัวอักษรของค าถาม ในส่วน Answer 
Font : ให้เลือกลักษณะตัวอักษรที่ต้องการ 
Text Colour : เลือกสีตัวอักษรของค าตอบ 
Background Colour : พื้นหลังของตัวอักษร การก าหนดข้อความในหน้าเฉลย 
Caption : ก าหนดเป็น “ค าตอบที่เลือก” 
Correct Answer Caption : ก าหนดเป็น “ค าตอบที่ถูกต้อง” 
Points Caption1 : ก าหนดเป็น “คะแนนในข้อนี”้ 
Points Caption2 : ก าหนดเป็น “คะแนนที่ได”้ ในช่อง Style Name : ให้ก าหนดช่ือ ตัวอย่างก าหนด

เป็น 123 และกด OK เสร็จสิ้นการเซ็ตค่าตัวอักษรและ ก าหนดค่าในการเฉลย 
 

6. การลงข้อสอบ 

 

ในขั้นแรกในช่อง Select Style Settings ให้เลือก Style ที่เราได้ก าหนดไว้เมื่อสักครู่ขึ้นมากอ่นแล้ว
จึงท าขึ้นตอน อื่น ๆ ต่อไป 

Order : เป็นค่าที่ก าหนดในการเรียงล าดับการเฉลยข้อสอบ 

QuestionID : เป็นค่าตัวแปรที่ใช้ในการส่งค่าคะแนนและเฉลย โปรแกรมจะรันอัตโนมัติสามารถ
แก้ไขได ้

Caption : แนะน าให้พิมพ์ค าว่า “ข้อที”่ จะไปปรากฏในหน้าเฉลยเป็นการรายงานข้อที่เฉลย 

Text to display : ใส่ค าถามดังตัวอย่าง 
Answer1, Answer2, Answer3, Answer4 : ให้พิมพ์ช้อย ก, ข, ค, ง ลงไปดังตัวอย่าง 
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ในช่อง Correct ให้คลิกเลือกข้อทีถู่กต้อง และในส่วนของช่อง Point ให้พิมพ์ค่าคะแนนที่ต้องการ
เช่น ข้อ นี้ถกูให้ 1 ก็พิมพ์เลข 1 ลงไป 

เสร็จแล้วคลิก OK ก็จะได้ข้อสอบข้อที ่1 ในหน้ากระดาษแล้วจึงไปจัดว่างตกแต่งตามความต้องการ 

 

ในการเพิ่มข้อก็ให้คลิกที่ปุ่ม Add Question และท าตามขั้นตอนที ่6 
7. เมื่อท าการลงขอ้สอบเสร็จแล้วในหน้าสุดท้ายของข้อสอบ จะมีการก าหนดปุ่มในการส่งข้อสอบ 

ตาม ขึ้นตอนตอ่ไปนี ้
- คลิกที่ปุม่ Add Submit Button 
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1. คลิกปุ่ม Edit เพื่อตั้งค่าตัวอักษรบนปุ่มและสีของปุ่มกด 
2. ในช่อง Caption ลบข้อความ Button แล้วให้ก าหนดตัวอักษรบนปุ่มลงไปใหม่ เช่น “ส่งข้อสอบ” เป็น ต้น 
3. ในส่วน Submit information 

- ในช่อง Method ให้เลือกเป็น No Information 
- และคลกิเช็คบ๊อกในช่อง View Result ไม่ต้องก าหนด Password 
- Items sent จะม ี2 ตัวเลือก 
          1. All หมายถึง ให้ส่งค่าตัวแปรทั้งหมดที่มี 
           2. Custom หมายถึง ให้ผู้สร้างก าหนดเองว่าจะเลือกค่าตัวแปรได้ไปปรากฏในหน้าเฉลย 
- แล้วคลิก OK เสร็จสิ้นการท าปุ่มส่งค่าค าตอบ 

8. การสร้างหน้ารายงานผลการท าแบบทดสอบ ตามขึ้นตอนต่อไปนี ้
- คลิกที่ปุม่ Edit Result Page 
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- จะปรากฏฟอร์มรายงานผลดังนี้ 

 

- สามารถตกแต่งพ้ืนหลังได้ด้วยการ Insert Image เข้ามาเหมือนหน้าหนังสือทั่วไป 
- ดับเบิ้ลคลิกที่ตัวอักษรภาษาอังกฤษและเปลี่ยนเป็นภาษาไทยเพื่อให้เข้าใจได้ง่ายขึ้นดังรูป 
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- ก าหนดค่าเช่ือมโยงดังนี้ 
กลับไปท าข้อสอบอีกครั้ง : Link   Page หน้าแรกของข้อสอบ 
ย้อนหลับ : ก าหนดค่า Link   Result Previous (หมายถึง เฉลยหน้าก่อนหน้านี)้ 
ถัดไป : ก าหนดค่า Link    Result Next (หมายถึง เฉลยหน้าถัดไป) 

- สร้างปุ่มเช่ือมโยงต่าง ๆ ตามความเหมาะสม 
- ในช่องส่ีเหลี่ยมที่โปรแกรมสร้างให้ 

ช่องที่ 1 คือค่าแสดงผลเฉลย ให้ดับเบิ้ลคลิกที่ช่องแล้วตั้งค่าตัวหนังสือและสีตัวหนังสือตาม 
ต้องการ 

ช่องที่ 2 คือค่าแสดงผลคะแนนทีไ่ด ้ให้ดับเบิ้ลคลิกที่ช่องแล้วตั้งค่าตัวหนังสือและส ี
ตัวหนังสือตามต้องการ 
- เสร็จสิ้นการท ารายงานผลการทดสอบ 

 

การสร้างปกหลังหนังสือ 

 
 
- เซฟไฟล์ต้นฉบับอีกครั้งคลิกท่ีเมนูบาร์ File > Save 
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การ Packageไฟล์ EXE 
 
1. คลิกที่เมนูบาร์ File Package EXE หรือคลิกที่รูปบนไอคอนบาร์ 

 
 

2. ก็จะได ้File.exe จัดเก็บไว้ในโฟลเดอร์เดียวกันกับที่เก็บไฟล์งานทั้งหมด 


